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SUMMARY

This report presents the activities of ISRIC - World Soil Information within the
framework of the Global Assessment of Land Degradation (GLADA) as a part of the
FAO program Land Degradation Assessment in Drylands (LADA). It describes a
common topographic format, at scale 1:1 million, for the partner countries
Argentina, China, Cuba, Senegal and The Gambia, South Africa and Tunisia. The
SRTM-DEM based GIS-procedures and definitions of the terrain-mapping units are
described, together with the first outputs of applied procedures for the partner
countries.

Keywords: SRTM-DEM derived landform procedures, SOTER landform, SOTER
databases, GLADA.
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1 INTRODUCTION

This report summarises an initial activity of ISRIC - World Soil Information within
the framework of the Global Assessment of Land Degradation (GLADA), which is
part of the FAO program Land Degradation Assessment in Drylands (LADA).

A main task of the GLADA program is to make a quantitative, global assessment of
land degradation, which is reproducible by defined procedures. This global
assessment will be carried out by remote sensing and measurement of deviance
from local norms. In this procedure ‘hot spots’ of land degradation will be assessed
by the normalised difference vegetation index (NDVI) derived from the reflected
wavebands measured by earth-observation satellites. The quality indicators of
these ‘hot spots’ will be derived from secondary remote sensing analysis and is
based on the stratification of the land area according to Soil and Terrain (SOTER)
units and land cover.

ISRIC'’s activities in this program are laid down in a Letter of Agreement PR 35825
between the Food and Agriculture Organisation of the United Nations and ISRIC -
World Soil Information, signed in February 2007.

This report describes the GIS-procedures in generating a common topographic
format for the six partner countries Argentina, China, Cuba, Senegal and The
Gambia, South Africa and Tunisia at a scale 1:1 million. These GIS-procedures are
based on the use of digital elevation data of the Shuttle Radar Topography Mission
(NASA 1998). The definitions of the terrain-mapping units and the first outputs of
such a Soil and Terrain database are presented here.

The method is described in Chapter 2, the preliminary results are discussed in
Chapter 3 and recommendations for further research are given in Chapter 4.

Due to the huge amount of raster cells of the China image and therefore problems
with some geo-processing tools in ArcGIS, another procedure was followed and
described in Chapter 2.2.6. (Data handling for China)
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2 MATERIALS AND METHODS

2.1 SRTM DEM information

The digital elevation model (DEM) of the Shuttle Radar Topography Mission (SRTM)
data consists of a GRID-map in geographic coordinates (WGS84). The coverage is
available between latitudes 60° North and 56° South. The original 1-arc second
resolution data has been resampled into 3-arc second resolution data (NASA 1998).
Areas with ‘no data’ have been filled by procedures developed by CGIAR-CSI. This
seamless dataset of 5° x 5° tiles was used for the six GLADA partner countries and
can be downloaded from:
http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp (CGIAR-CSI 2004).

The GRID-file supplies detailed information on the elevation of the land surface at a
resolution of 90 m at the equator and is referred to as DEM data.

The original GRID data has been analysed for three parameters, following a method
developed by Dobos et al.(2005) and used to generate the GIS layers for:
« Elevation
+ Slope
« Relief intensity (RI) - the median difference within one km? circle around the
pixel in consideration.

The individual values for elevation, slope and relief intensity were combined,
recoded and generalized into new, combined classes to assign SOTER landform
classes, using slightly adapted SOTER criteria (van Engelen and Wen 1995; van
Engelen and Huting 2004), see Annex 1.

The dissection, referred to as potential drainage density (pdd) by Dobos et al.
(2005) has not been used in the present analysis for the landforms. This criterion
did not add much value in discriminating the landform at the present scale, as
discrimination was based already on the combination of the three parameters,
slope, relief intensity and elevation.

Five steps were made to process the SRTM DEM data, using ArcGIS Desktop
version 9.2 (ESRI 2006): (see chapter 2.2)

. pre-treatment of the SRTM-DEM data

» deriving elevation, slope and relief

. reclassification of the GRIDs

+ generalization of the combiGRID

» generalization of the shapefiles for individual countries

Finally, a SOTER landform class is assigned to each GRID code and the landform
classes added to the shapefiles.
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2.2 Data handling

Data handling procedures are described in general terms only.

2.2.1 Pre-treatment SRTM 90m DEM

Convert the image files (GeoTiff format) to raster files (GRIDS) and merge or
mosaic the tiles to full coverage for each country.
Convert values >= 32768 to ‘no data’ using the raster calculator:
Setnull([GRID] >=32768,[GRID])
Replace all negative values with 0O:
Con([GRID]<0,0,[GRID])

Remark:
The elimination of all negative values implies that all surfaces that lie under mean
sea level are displayed as ‘0’ or ‘no data’ on the map.

“Clip by mask” with polygon theme (+ buffer of 50 km) of the area to be analyzed.
Put the resulting GRID in projected coordinates of an equal area projection for
metric calculations, e.g. standard projection Lambert Azimuthal Equal Area with
‘central meridian’ and ‘latitude of origin’ in geographic coordinates. These two
values are the centroid of the polygon theme.

The resulting GRID is the base for further analyses. >ElevGRID

2.2.2 Deriving elevation, slope and relief

Using the previous GRID (elevGRID) and:
Neighbourhood statistics; Focalstats_ MEDIAN, circle 6 cells >Elevgen

Neighbourhood statistics; Focalstats RANGE, circle 6 cells
Neighbourhood statistics; Focalstats_ MEDIAN, circle 6 cells > Reliefgen

Spatial Analyst; Surface Analysis; Slope % (slopeGRID)
Neighbourhood statistics; Focalstats_ MEDIAN, circle 6 cells ->Slopegen

Or:

For very large areas (larger than 1 million km?); multiply slopegrid by 100 and
make it an integer.

Use Raster Calculator: Int(slopeGRID)

Neighbourhood statistics; Focalstats_ MEDIAN, circle 6 cells >Slopegen

2.2.3 Reclassification of GRIDs

Each GRID is reclassified on the basis of elevation, slope and relief intensity
(Elevgen, Slopegen and Reliefgen) and given a code (reclassified). The individual
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codes are combined (Table 1) and assigned a new combined class code, the Combi-
code.

Table 1: GRID derived Combicode

Elevgen Code Slopegen Code Reliefgen Code Combi
(masl) Recl. (%) Recl. (m/km?) Recl. code

<10 10000 <0.5 1000 <50 100 11100
10-50 20000 0.5-2 2000 50-100 200 22200
50-100 30000 2-5 3000 100-150 300 33300
100-200 40000 5-10 4000 150-300 400 44400
200-300 50000 10-15 5000 >300 500 55500
300-600 60000 15-30 6000 66x00
600-1500 70000 30-45 7000 77x00
1500-3000 80000 >45 8000 88x00
>3000 90000 9xx00

Combine reclassified grids: Elevgen + Slopegen + Reliefgen >CombiGRID

2.2.4 Generalization of the CombiGRID

Using CombiGRID and Neighbourhood Statistix:
Focalstats MAJORITY, circle 6 cells -> Combigen

“No data” substitution in Combigen with data from CombiGRID:

Con (Isnull([Combigen]),[CombiGRID],[Combigen]) -> Combisubst
Region Group Combisubst - RegionGcombi
Extract by attributes: for “count>121" > Extr_Region

Clusters of grid-cells with a surface area <121 cells are converted to ‘no data’; this
corresponds with about 1 km?on the map and is used as area of generalization.

Nibble:
Combisubst (input raster) and Extr_Region (input raster mask) - Nibble 121

(Nibbling is replacing ‘no data’ values in the raster with neighbouring values, as
follows: replace in the input raster (Combisubst) the cells corresponding to “no
data” cells of input raster mask (Extr_Region) with the nearest neighbours’ values
of Combisubst (input raster).

Extraction by mask with polygon extent: > Nib_121_extr
(Both polygon layer and GRID layer must have a defined projection).

Raster to polygon conversion (conversion to shapefiles) > Nibble 121
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Join the shapefile on GRIDCODE and VALUE of RegionG_combi, and export to a new
shapefile in ArcMap.

2.2.5 Generalization of the shapefile

Project the shapefile (Nibble_121) to geographic coordinates.

- Prior_Jenness_geo
In ArcView 3.x, retrieve the “Prior_Jeness_geo” shapefile.
Check "“Dissolve Adjacent Polygons v. 1.8" in file - Extensions

This extension of “Jenness Enterprise” is downloadable from:
http://www.jennessent.com/arcview/dissolve adjacent polys.htm (Jenness 2006).

Open in View > Properties: set the map units to Meters and Projection: Projection
of Hemisphere: Lambert Azimuthal Equal-Area.

Check “custom”, fill in the “Central Meridian” and the “Reference Latitude” and quit
with OK > OK

Start extension (button) @
Select Polygon Theme and Dissolve Options:

Pleaze select Select PalygonT heme

- POLYGOM Theme - -1D Field - i
Cuba_nib121_dizz25km_sl - Mo 1D Field - - {
i 4
N A

Sakm
Elevation </—( >
— Slope J 'i—““
Dizzolve all polygons smaller than 25000000 2q. map units

" Dizzolve all polygons within size range

* Dizzolve only selected polygons within size range [0 selected)

[v Only combine adjacent polygons with zame attribute value

Dizzolve Paolygon [nto: Adjacency Options:
™ Smallest Adjacent Polygon " Share common paint or vertex
¢ Largest Adiacent Palygon % Share common line ar border
% Polpgon with Longest Adjacent Border Cancel ok

Figure 1: Opening screen of dissolve options

Select Polygon Theme

Select Polygon Theme ID: Gridcode

Dissolve all polygons smaller than 25000000 map units (=25 km?)
Dissolve all polygons within size range.

Only combine adjacent polygons with same attribute value
Attribute field: Slope_class (1 to 8)

Dissolve Polygon with Longest Adjacent Border
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Share common line or border ->0K
Give path and name - After_Jenness_geo

*When processing is ready, project the shapefile to Lambert Azimuthal
- After_Jenness_proj

The shapefile must have a defined (equal area) projection, e.g. standard Lambert
Azimuthal Equal Area.

Add a new field, ‘sq_km’ to the attribute table of the shapefile and calculate the
polygon area;
Type: Double; Precision:10; and Scale: 3

In the field calculator: check for advanced, and fill in the codes;
Dim dblArea as double
Dim pArea as IArea
Set pArea = [shape]
dblArea = pArea.area

and at ‘sq_km="fill in; dblArea/1000000

Save this expression file as; sq_km.cal (easy use).

Select all polygons < 25 km?

In Arc toolbox: Eliminate with “Eliminate polygon by border checked on.
>Eliminate_25

Recalculate SQKM, select polygons < 25 km? and repeat Eliminate procedure
2>Eliminate_25 2

Check if all polygons (except the stand-alone polygons) have been dissolved (if not:
recalculate SQKM, select all polygons < 25 km? and repeat Eliminate again)

Remove stand-alone polygons with SQKM <25:

Select all polygons <25 km?; switch selection in the attribute table (options) and
export data to a new shapefile > Eliminate_25_1Islands
(This is the shapefile without stand-alone polygons <25km?)

Join the shapefile with the Combi3 table on the code field.

Export this file to a new shapefile > Combi3_25km (the fields of the join table will
be included in this new shapefile).

Dissolving on gridcode:

Dissolve Combi3_25km on Gridcode -> Combi_25km_diss
Convert multipart to single part polygons. -> Combi3_25km_single
Recalculate the field SQKM
Convert the shapefile from projected to geographic coordinates (WGS 1984)

- Combi_25km_geo

Dissolve Combi3_25km_single on Landform field (SOTER landform)
>Combi3_25km_landform
Convert multipart to single part polygons > Combi3_25km_landform_single
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Recalculate the field SQKM
Convert the shapefile from projected to geographic coordinates (WGS 1984)
-> Combi3_25km_geo_SOTER

Import the both shapefiles in ArcMap and make/import layer files (legends).
Remarks:

A cluster of 3025 grid cells corresponds with about 25 km? or 0.25 cm? on the map.
This is the minimum size of the polygons usually depicted on maps at scale 1:1M.

2.2.6 Data handling for China

The same procedure has been followed as described in chapter 2.2, up to the
creation of the input raster “Combisubst”, under 2.2.4.

Extract China from the Harmonized World Soil Database (HWSD), which is a 30 arc-
second raster database (FAO/IIASA/ISRIC/ISSCAS/JRC 2008):

In ArcToolbox ->Spatial Analyst Tools —>Extraction ->Extract by Mask
2>Extract_ HWSD
(Mask data is the polygon boundary of China)

Convert the raster data to a polygon map:
In ArcToolbox ->Conversion Tools —>from Raster ->Raster to Polygon
->Extract_ HWSD.shp

Proceed as mentioned under 2.2.5, *When processing is ready, project etc.
2HWSD_poly_geo

Attach the combicodes to the shapefile:

ArcToolbox  —>Spatial Analyst Tools >Zonal ->Zonal Statistics
Input raster or feature zone data: HWSD_poly_geo.shp
Zone field: ID

Input value raster: Combisubst
Output raster: ZonalSt_HWSD
Statistics: MAJORITY

Join the resulting table to the shapefile and export to a new shapefile:
>HWSD_poly_zonal_geo

Join the shapefile with the Combi3 table on the code field and export to a new
shapefile 2HWSD_poly_final_geo
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2.3 Conversion of GRID maps to landform maps

The reclassified codes for elevation, slope and relief intensity are combined in a new
GRID code that comprises five digits of which the last two are zero for the
(presently not used) drainage density. See also 2.1. These combined GRID codes
are similar to the Combicodes in Table 1.

The GRIDCODE is used to link the GIS file to the key table for landform and to
generate a SOTER landform map. Appendix 2 gives the major landform classes as
assigned to the combined GRIDCODE or Combicodes that occur in the GIS derived
landform database. A SOTER landform alternative is given for those Combicodes
where the assigned landform does not fit completely the existing SOTER criteria or,
when more than one landform is possible.

This particular problem arises when one of the classes on slope or relief intensity
does not fit the combination of SOTER criteria. This is the case e.g. when the relief
intensity is sufficiently high to fall in the landform category SP (dissected plain) or
even SH (medium gradient hill), but the slope is only between 5-10 percent and
classifies as level land. In such cases, dissected plain is selected, because of its
high relief intensity, and alternative landforms are indicated in the adjacent column.
More of such cases will occur for different combinations of elevation, slope and
relief intensity. These cases have still to be reviewed, using the different layers in
the GIS analyses, and taking into account the surrounding landform.

Because of the rather rigid conversion from the GRIDCODE into the SOTER
landform, available information is not shown on the map. Using a different legend
can help to retain more information. The use of a legend with multi-stage classes or
a more sliding scale, formed on basis of slope, relief intensity and elevation (SRE
classes) show already more detail, also for those areas where the SOTER landform
maps appears to be very uniform.

Under the heading, ‘Meaning’ (Appendix 2), combinations of the maximum possible
values of the SOTER criteria ranges are given for elevation (E), slope (S) and relief
intensity (R). The GRIDCODE and the SRE class in the table represent a unique
code for each of the combinations and is depicted on a map (Figure 2 to Figure 13).

For the SOTER landform codes and criteria, see Appendix 1.
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3 RESULTS AND DISCUSSION

The SOTER landform maps of the six LADA partner countries at scale 1:1 million are
presented in the Figures 2 to 13 (jpeg format), together with the maps of grouped
SRE classes (also included on CD-rom in ArcMap format).

All polygons smaller than 25 km? were eliminated from the spatial database and
assigned to a neighbouring polygon with the longest common border, using the
Jenness procedure (Jenness 2006). The Jenness procedure, dissolving small,
adjacent polygons, is the best solution to eliminate small polygons. This is allowed
at the present scale of 1:1 million, but elimination of these polygons smaller than
25 km? created a much more generalized landform map. The question is if
elimination of all these small polygons is not a too large loss of information that is
originally available.

Therefore, different types of legends are tried to depict the classified information on
a map. Included are maps showing a legend with multi-stage classes, based on
slope, relief and elevation (SRE classes), which are also derived from the same
GRIDCODE, but in a different sequence. See Appendix 2. Slope is here the
dominant criteria, followed by relief intensity and elevation; the groupings for the
legend follow the standard criteria as given in the SOTER manual (van Engelen and
Wen 1995). These maps, giving the landform with only eight SRE classes in their
legend, have retained more of its detail. It demonstrates one of the possibilities of
the SRTM 90m DEM analysis (much detail) compared to the SOTER landform map
(less detail). However, a legend with only coding does not link to or give any
recognition with actual landform features, as experienced when doing fieldwork.

Another problem arises in the SOTER landform classification. All land with relief
intensity (RI) less than 50 m and slope less than 10% is termed ‘level land’ and
indicated as plain (LP). No other level landform, as plateau (LL) or valley floor (LV),
could automatically be assigned as the SOTER criteria for these landforms are
similar to those for plain. See Appendix 1. Only in their position compared to the
surrounding landform can they be sufficiently discriminated. This holds also for
some sloping and steep SOTER landforms; criteria to discriminate these SOTER
landforms have yet to be developed. Assigning only one landform to ‘level land’ has
limited the number of landforms in the database. In the present database, seven
landforms are indicated, while potentially the SOTER manual distinguished 14
landforms (Appendix 1).

The conversion of the GRIDCODES (Combicodes) to the SOTER landforms is not
obvious for all cases and more landform possibilities exist, e.g. when slope is <10%
and RI > 100 mkm?. In such cases, a single (SOTER) landform and an alternative
landform are indicated, e.g. LP/LF/SP/SH; this can be described as ‘level to sloping
land’ (Appendix 2). When more then one landform is possible, the assignment is
first based on slope and secondly on RI. In the Figure 2 to Figure 13 only single
(SOTER) landforms are given.
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Polygons for water bodies and lakes are imported from the ESRI World Base Map
data (ESRI 2005). In two cases, the database gives temporal lakes as permanent
water surface; these are the ‘salinas’ in Argentina and the “shotts” Tunisia (Times
2003). Especially in Tunisia, more temporary water bodies are given as lakes.

Due to the followed procedures, depressions below mean sea level (negative
elevation) are not shown on the landform maps. Examples are the Turpan
depression in China (south of the city Uriimgi) and in Argentina the depressions
‘Salina Gaulicho’ (north of San Antonia Oeste, Rio Negro province) and a part of the
‘Gran Baja de San Julian’ (north of Rio Chico between San Julian and Santa Cruz,
Santa Cruz province). In Tunisia, this Shott el Gharsa lies about 15 m. below sea
level.
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Landforms SOTER

- Plain wet

I:l Plain

I:l Dissected plain

I:l Medium-gradient hill
I:l Medium gradient mountain
I:l High -gradient hill

- High-gradient mountain
l:l Waterbodies

Figure 2:

SOTER landform of Argentina
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Landforms SRE class

I 111 - 159
[ 211- 259
311 - 359
[ ]411-459
[ ]511-559
[ s11-659
I 711- 759
B -850
|:| Waterbodies

Figure 3: Landform with SRE classes for Argentina
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Figure 4:

Landforms SOTER

- Plain wet

[ ]Pain

l:l Dissected plain
l:l Medium-gradient hill
l:l Medium gradient mountain
[ ] Hign -gradient hill

- High-gradient mountain

SOTER landform of China



14 GIS-procedures for mapping SOTER landform

Landforms SRE class

I 111 - 159
[ 211 - 259
[ 311 - 359
[ Ja11-459
[ ]511-559
[ 611 - 659
I 711 - 750
I 511 - 850

Figure 5: Landform with SRE classes for China
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Medium gradient mountain

High-gradient hill

High-gradient mauntain

Figure 6: SOTER landform of Cuba
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Landforms SRE class ’

B 150
B 211 - 259
I 511 -359
[ 211-459
[ 1s11-589
I 611 - 659
-
B - ss0

Figure 7: Landform with SRE classes for Cuba
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Figure 8: SOTER landform of South Africa
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Landforms SRE class

111- 159

211-259

311-359

411 - 459

511- 559

611-659

711-759

811-859

SN

Figure 9: Landform with SRE classes for South Africa
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Figure 10: SOTER landforms of Senegal and The Gambia
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Landforms SRE class
I 111159
B 211 - 259
[ 311-359
[ J411-459
[ ]st11-559
[ 611 -659
B 711 -759
I 811 - 859

Figure 11: Landforms with SRE classes for Senegal and The Gambia
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Landforms SOTER

|:| Dissected plain

|:| Medium-gradient hill
|:| Medium gradient mountain
[ ] High -gradient hill

- High-gradient mountain

l:l Waterbodies

Figure 12: SOTER landform of Tunisia
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Landforms SRE class

B 11- 159
[ 211-259
[ ]31-359
[ ]411-459
[ ]51-559
[ 611-659
B 711 -759
B a1 -850
|:| Waterbodies

Figure 13: Landform with SRE classes for Tunisia
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4 CONCLUSIONS

The SRTM 90m DEM-derived landform maps give more detail compared to the
manually-derived landform maps from the traditional SOTER database for Argentina
and Cuba (Dijkshoorn et al. 2005; FAO et al. 1998), and South Africa (FAO et al.
2003). Landform, based on SRE class groupings gives even more detail, but is not
linked to actual SOTER landforms.

Further work is needed to discriminate between landforms that are based on not
yet GIS-quantified SOTER criteria. This is e.g. the case for the landforms plateau
and depression, which are level land at higher respectively lower position than the
surrounding land, and in transition bounded by an escarpment, respectively by
sloping land. All level land is now assigned as plain (LP), but may include the
traditional SOTER landform plateau, depression, footslope and river basin/valley
floor. These landforms are not assigned in the present database, as no GIS-based
discrimination could be made. A further refinement of the GIS-based methods is
needed to discriminate between these other landforms of ‘level land’. Likely, a
manual inspection of a number of polygons and expert judgement will be necessary
now to differentiate such units from the landform plain.

Further research on the refinement of the GIS procedures are needed e.g. in
generalization procedures and standards, in potential drainage density (pdd), which
was not used for our analysis and likely in a slight adaptation of the SOTER
landform criteria.

The present procedure without discrimination between ‘level land’ has resulted in
an overestimation of the landform plain (LP). A similar situation can occur for
dissected plain (SP). Polygons e.g. with a too low relief intensity for ‘medium
gradient hill’ (RI < 100 m/km?, but with slopes >15%) are assigned dissected plain.
Underestimated are the landform plateau, depression, low gradient footslope, valley
floor, medium and high gradient escarpment zone, and medium and high gradient
valley.

Due to the procedure followed, depressions with elevations reaching below mean
sea level (negative elevation), are left blank on the map, e.g. Turpan depression in
China. Some of them are indicated water bodies and are temporal lakes, e.g. Chott
el Gharsa.
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APPENDICES

Appendix 1:

Hierarchy of major landforms (adapted)

1st level 2nd level gradient relief
(%) intensity
(m.km™)
L level land LP plain <10 <50
LL plateau <10 <50
LD depression <10 <50
LF low gradient footslope <10 <50
LV valley floor <10 <50
S sloping land SE medium-gradient 10-30 100-150
escarpment zone
SH medium-gradient hill 10-30 100-250
SM medium-gradient 15-30 150-300
mountain
SP dissected plain 10-30 50-100
SV medium-gradient valley 10-30 100-150
T steep land TE high-gradient >30 150-300
escarpment zone
TH high-gradient hill >30 150-300
TM high-gradient mountain >30 >300
TV high-gradient valley >30 >150

Source: SOTER manual (van Engelen and Wen 1995), revised not published
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Appendix 2:

GRIDCODE key for landform and SREclass
(slope, relief intensity and elevation)

GRID Elevation Slope Relief Meaning Landform  Landform
SRE class

CODE m % m (SOTER) alternative

11100 111 <10 0-0.5 0-50 E10_S0.5 R50 LP wet

12100 211 <10 0.5-2 0-50 E10_S2 R50 LP

13100 311 <10 2-5 0-50 E10_S5 R50 LP

14200 421 <10 5-10 50-100 E10_S10_R100 LP SP

21100 112 10-50 0-0.5 0-50 E50_S0.5_R50 LP

22100 212 10-50 0.5-2 0-50 E50_S2 R50 LP

22300 232 10-50 0.5-2 100-150 E50_S2_R150 LP

23100 312 10-50 2-5 0-50 E50_S5 R50 LP

23200 322 10-50 2-5 50-100 E50_S5 R100 LP LF/SP/SH

24100 412 10-50 5-10 0-50 E50_S10 R50 LP

24200 422 10-50 5-10 50-100 E50_S10 R100 LP SP

25200 522 10-50 10-15 50-100 E50_S15 R100 SP

26200 622 10-50 15-30 50-100 E50_S30_R100 SH SE/SV

26300 632 10-50 15-30 100-150 E50_S30_R150 SH

31100 113 50-100 0-0.5 0-50 E100_S0.5 R50 LP

32100 213 50-100 0.5-2 0-50 E100_S2 R50 LP

32200 223 50-100 0.5-2 50-100 E100_S2 R100 LP

33100 313 50-100 2-5 0-50 E100_S5 R50 LP

33200 323 50-100 2-5 50-100 E100_S5 R100 LP LF/SP/SH

34100 413 50-100 5-10 0-50 E100_S10_R50 LP

34200 423 50-100 5-10 50-100 E100_S10 _R100 LP SP

35200 523 50-100 10-15 50-100 E100_S15 R100 SP

35300 533 50-100 10-15 100-150 E100_S15 R150 SH SE/SV

36300 633 50-100 15-30 100-150 E100_S30_R150 SH

36400 643 50-100 15-30 150-300 E100_S30_R300 SH SM

41100 114 100-200 0-0.5 0-50 E200_S0.5 R50 LP

42100 214 100-200 0.5-2 0-50 E200_S2 R50 LP

43100 314 100-200 2-5 0-50 E200_S5_R50 LP

43200 324 100-200 2-5 50-100 E200_S5 R100 LP LF/SP/SH

44100 414 100-200 5-10 0-50 E200_S10_R50 LP

44200 424 100-200 5-10 50-100 E200_S10_R100 LP SP

44300 434 100-200 5-10 100-150 E200_S10_R150 LP SE/SVISP

45200 524 100-200 10-15 50-100 E200_S15 R100 SP

45300 534 100-200 10-15 100-150 E200_S15 R150 SH SE/SV

46200 624 100-200 15-30 50-100 E200_S30 _R100 SH SE/SVISP

46300 634 100-200 15-30 100-150 E200_S30_R150 SH

46400 644 100-200 15-30 150-300 E200_S30_R300 SH SM

47400 744 100-200 30-45 150-300 E200_S45 _R300 TH TMITE/TV

51100 115 200-300 0-0.5 0-50 E300_S0.5 R50 LP LD

52100 215 200-300 0.5-2 0-50 E300_S2 R50 LP

52200 225 200-300 0.5-2 50-100 E300_S2_R100 LP SP

53100 315 200-300 2-5 0-50 E300_S5 R50 LP

53200 325 200-300 2-5 50-100 E300_S5 R100 LP LF/SP/SH

54100 415 200-300 5-10 0-50 E300_S10_R50 LP

54200 425 200-300 5-10 50-100 E300_S10_R100 LP SP

54300 435 200-300 5-10 100-150 E300_S10_R150 LP SE/SVISP

55200 525 200-300 10-15 50-100 E300_S15 R100 SP
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GRID Elevation Slope Relief Meaning Landform  Landform
SRE class

CODE m % m (SOTER) alternative
55300 535 200-300 10-15 100-150 E300_S15 R150 SH SE/SV
56300 635 200-300 15-30 100-150 E300_S30 R150 SH

56400 645 200-300 15-30 150-300 E300_S10 R300 SH SM

57300 735 200-300 30-45 100-150 E300_S45 R150 TH TE/TV
57400 745 200-300 30-45 150-300 E300_S45 R300 TH TMITE/TV
61100 116 300-600 0-0.5 0-50 E600_S0.5 R50 LP

62100 216 300-600 0.5-2 0-50 E600_S2 R50 LP

62200 226 300-600 0.5-2 50-100 E600_S2_R100 LP SP

63100 316 300-600 2-5 0-50 E600_S5 R50 LP

63200 326 300-600 2-5 50-100 E600_S5 R100 LP LF/SP/SH
64100 416 300-600 5-10 0-50 E600_S10 R50 LP

64200 426 300-600 5-10 50-100 E600_S10 R100 LP SP

64300 436 300-600 5-10 100-150 E600_S10_R150 LP SE/SVISP
65200 526 300-600 10-15 50-100 E600_S15 R100 SP

65300 536 300-600 10-15 100-150 E600_S15 R150 SH SE/SV
66200 626 300-600 15-30 50-100 E600_S30_R100 SH SE/SVISP
66300 636 300-600 15-30 100-150 E600_S30_R150 SH

66400 646 300-600 15-30 150-300 E600_S30 _R300 SH SM

66500 656 300-600 15-30 >300 E600_S30 R>300 SM SE

67300 736 300-600 30-45 100-150 E600_S45 R150 TH TMITE/TV
67400 746 300-600 30-45 150-300 E600_S45 R300 TH TMITE/TV
67500 756 300-600 30-45 >300 E600_S45 R>300 ™

68400 846 300-600 >45 150-300 E600_S>45 R300 TH ™

68500 856 300-600 >45 >300 E600_S>45 R>300 TM

71100 117 600-1500 0-0.5 0-50 E1500_S0.5 R50 LP

72100 217 600-1500 0.5-2 0-50 E1500_S2 R50 LP

73100 317 600-1500 2-5 0-50 E1500_S5 R50 LP

73200 327 600-1500 2-5 50-100 E1500_S5 R100 LP LF/SP/SH
74100 417 600-1500 5-10 0-50 E1500_S10_R50 LP

74200 427 600-1500 5-10 50-100 E1500_S10_R100 LP SP

74300 437 600-1500 5-10 100-150 E1500_S10_R150 LP SE/SVISP
75200 527 600-1500 10-15 50-100 E1500_S15 R100 SP

75300 537 600-1500 10-15 100-150 E1500_S15 R150 SH SE/SV
75400 547 600-1500 10-15 150-300 E1500_S15 R300 SH

76200 627 600-1500 15-30 50-100 E1500_S30_R100 SH SE/SVISP
76300 637 600-1500 15-30 100-150 E1500_S30_R150 SH

76400 647 600-1500 15-30 150-300 E1500_S30_R300 SH SM

77300 737 600-1500 30-45 100-150 E1500_S45 R150 TH TE/TVISH
77400 747 600-1500 30-45 150-300 E1500_S45 R300 TH

77500 757 600-1500 30-45 >300 E1500 _S45 R>300 TM

78400 847 600-1500 >45 150-300 E1500_S>45 R300 TH TMITEITV
78500 857 600-1500 >45 >300 E1500 S>45 R>300 TM

81100 118 1500-3000 0-0.5 0-50 E3000_S0.5 R50 LP

82100 218 1500-3000 0.5-2 0-50 E3000_S2_R50 LP

83100 318 1500-3000 2-5 0-50 E3000_S5_R50 LP

83200 328 1500-3000 2-5 50-100 E3000_S5 R100 LP LF/SP/SH
84100 418 1500-3000 5-10 0-50 E3000_S10_R50 LP

84200 428 1500-3000 5-10 50-100 E3000_S10_R100 LP SP

84300 438 1500-3000 5-10 100-150 E3000_S10_R150 LP SE/SVISP
85200 528 1500-3000 10-15 50-100 E3000_S15 R100 SP

85300 538 1500-3000 10-15 100-150 E3000_S15 R150 SH SE/SV
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GRID Elevation Slope Relief Meaning Landform  Landform
SRE class

CODE m % m (SOTER) alternative

86200 628 1500-3000 15-30 50-100 E3000_S30_R100 SH SE/SVISP

86300 638 1500-3000 15-30 100-150 E3000_S30_R150 SH

86400 648 1500-3000 15-30 150-300 E3000_S30_R300 SH SM

87300 738 1500-3000 30-45 100-150 E3000_S45 R150 TH TE/TVISH

87400 748 1500-3000 30-45 150-300 E3000_S45 R300 TH TMITE/TV

87500 758 1500-3000 30-45 >300 E3000_S45 R>300 TM

88400 848 1500-3000 >45 150-300 E3000_S>45 R300 TH TMITEITV

88500 858 1500-3000 >45 >300 E300 S>45 R>300 TM

91100 119 3000-5000 0-0.5 0-50 E5000_S0.5 R50 LP

92100 219 3000-5000 0.5-2 0-50 E5000_S2_R50 LP

93100 319 3000-5000 2-5 0-50 E5000_S5 R50 LP

93200 329 3000-5000 2-5 50-100 E5000_S5 R100 LP LF/SP/SH

94100 419 3000-5000 5-10 0-50 E5000_S10_R50 LP

94200 429 3000-5000 5-10 50-100 E5000_S10_R100 LP SP

94300 439 3000-5000 5-10 100-150 E5000_S10_R150 LP SE/SVISP

95200 529 3000-5000 10-15 50-100 E5000_S15 R100 SP

95300 539 3000-5000 10-15 100-150 ES5000_S15 R150 SH SE/SV

95400 549 3000-5000 10-15 150-300 E5000_S15 R300 SH

96300 639 3000-5000 15-30 100-150 E5000_S30_R150 SH

96400 649 3000-5000 15-30 150-300 E5000_S30_R300 SH SM

97400 749 3000-5000 30-45 150-300 ES5000_S45 R300 TH TMITE/TV

97500 759 3000-5000 30-45 >300 E5000_S45 R>300 TM

98400 849 3000-5000 >45 150-300 E5000_S>45 R300 TH TMITEITV

98500 859 3000-5000 >45 >300 E5000 S>45 R>300 TM
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